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3 Unity 入門
　─ 5分で作れるドミノ倒し─

Unityとは？

Unity はインタラクティブソフトウェア開発の
ための統合開発環境
　みなさん Unityについて一度はどこかで聞いた

ことがあるのではないでしょうか．Unityは団結を

意味する英単語でさまざまな社会問題，政治問題な

どに対して Unityが叫ばれる状況を昨今目にしま

すが，ここでいう Unityはそちらではなく統合開

発環境の Unityのことです．

　Unityはゲームエンジンを謳っています．ゲーム

開発に情報処理の知見は必須といえますが，本会で

も特にゲーム開発には縁がない，という方が大半で

しょう．しかし，ゲームエンジンというのはグラ

フィック，物理シミュレーション，ユーザインタ

フェース，通信など多くの機能を開発するために設

計されたソフトウェアであり，必ずしもゲーム開発

に限らず多くの分野で利用されており，本会でも多

くの分野の研究デモンストレーションや関連する製

品開発などに使われています．

Unity の活用
　Unityの利用でもっとも多いのはもちろんゲー

ム開発分野です .代表的なソフトウェアとして

は『Pokémon Go』などが挙げられます．ほかにも

Apple社のプレゼンなどでよく取り上げられる『ク

ロッシーロード』や『Monument Valley』など多く

のゲームAppがUnityを使って開発され，その割

合は実にスマートフォンゲームの 30%以上にも上り，

スマートフォンのゲーム開発においてはデファクト

スタンダートな存在といわれます．

　また，VR/AR開発においてもUnityは非常にメ

ジャーです．多くのVRゲームはもちろん，Googleの

『Tilt Brush』のような 3D空間に絵を描くソフトウェ

アやアメリカ航空宇宙局（NASA）の『OnSight』な

ど専門性の高い分野での利用も盛んです．

　シンガポール国立博物館に展示されているチーム

ラボ制作の『Story of the Forest』は長さ 120メート

ルに及ぶ巨大なプロジェクションマッピング作品で

すが，複数台のPCをUNETと呼ばれるUnityのネッ

トワークの仕組みで同期し映像を投影しています．

　近年はインタラクティブ作品のみならず，映像作

品での利用も増えています．映像制作会社マーザ・

アニメーションプラネットの『THE GIFT』，子供

向けのアニメ番組『魔法つかいプリキュア』のエン

ディング映像では Unityをレンダラとして活用し

ています．また，東映アニメーションはアニメ『正

解するカド』の中で 3Dフラクタルの立体物の内部

を表現するのに Unityを用いました．

　さらにUnity Technologiesでは『Adam』（図 -1）☆ 1

とその続編『Adam E2 : The Mirror』☆ 2などのフォト

リアル表現を用いたリアルタイムショートムービー

を発表しています．

研究や教育でのUnity
　さまざまな分野で活用されている Unityですが，

☆ 1 https://unity3d.com/jp/pages/adam
☆ 2 https://youtu.be/R8NeB10INDo
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多くの大学で研究用途でも利用されています．たと

えばバーチャルリアリティの分野では特に利用率が

高く，バーチャルリアリティ学会のデモ展示や国際

学生対抗バーチャルリアリティコンテスト☆ 3など

では多くのデモや作品が Unityを使って作成され

ています．

　たとえば IVRC 2013の総合優勝作品である『バー

チャルロープスライダー』（図 -2）☆ 4はヘッドマウント

ディスプレイをつけた体験者がぶら下がったロープを

Unityで作られたソフトウェアからArduino経由で適

切に揺らすことで疾走感を演出するバーチャルリアリ

ティコンテンツです．感覚や体験の仕組みの新規性が

重視され，コンテンツ映像の質を高めることが本質で

はないため，ゲームエンジンのように短い作業時間で

インタラクティブ映像を提示することができる仕組み

を利用すると全体の体験設計や機構の調整などにより

多くの時間を割くことができます． 

　筆者は東京大学廣瀬・谷川・鳴海研究室との共同

研究で視触覚感相互作用を利用したバーチャルリア

リティシステム『Unlimited Corridor』☆ 5を発表し

ています．視触覚感相互作用を用いることで体験者

の空間認知をねじ曲げ，直径 5メートルの円筒を触

りながら歩いているのに直進しているような感覚を

与えるというものです．モーションキャプチャシス

テムを使って体験者の位置を得て，Unityで作られ

たバーチャルリアリティ空間内の位置に変換しヘッ

☆ 3 http://ivrc.net/2017/
☆ 4 http://im-lab.net/virtualropeslider/
☆ 5 http://www.cyber.t.u-tokyo.ac.jp/~matsumoto/unlimitedcorridor.

html

ドマウントディスプレイに映像を提示しています．

　このように元々コンピュータグラフィクスやイン

タラクティブソフトウェアを用いた研究発表を行う

分野では当然のようにUnityの活用が進んでいます

が，その影響はほかにも医療，建築，心理学など情

報処理の知見が活かされる多くの分野に及びます．

　医療分野でいうと東京大学脳神経外科では Unity

を用いたソフトウェアで手術前検討を行い，複数の

患者の手術を成功させています 1）．このケースでは

医師自らが Unity，Maya，ZBlushなどのソフトウェ

アを学習し自身の専門を活かしたソフトウェア制作

を行っているという点がポイントです．学習コスト

が十分に下がっているため，外注先に専門について

理解してもらうよりも専門性の高い人間がソフト

ウェア制作を学んだ方が速い，ということがあり得

る時代になってきたといえるでしょう．

Unityを学ぶ

Unity は簡単か？
　「Unityを使うと簡単にゲームが作れる」という

ような言い方をしばしば見かけますが本当に簡単で

しょうか？　実のところ Unityの公式やスタッフ

の間ではそういった言い方をすることはまずありま

せん．「Unityを使うと簡単」というのはあくまで

従来の方法や他開発環境との比較の話です．たとえ

ばジャンケンをするためのインタラクティブソフト

ウェアを作ろうと思ったら画面の表示，ユーザから

の入力，入力に対する結果の計算，結果のフィード

バックなどが必要です．研究でこういうことをする

際にいちばん注力すべきなのは入力に対する計算，

アルゴリズムの部分です．それ以外の労力は可能な

■図 -1　『Adam』 ■図 -2　『バーチャルロープスライダー』
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限り少ない方がよいでしょう．

　Unityは元々ゲーム開発をするためのものですか

ら，ゲーム開発に必要な機能は一通り揃っていま

す．たとえばスプライトの表示やアニメーションの

管理と遷移のためのシステム，ポリゴンの表示やオ

ブジェクトの管理，当たり判定を始めとする物理演

算，ユーザインタフェースの作成機能，3Dオブジェ

クトへのライティングやその他さまざまな画面効果

をつける機能などがあります．これらはほんの一例

ですが，たとえば画面の任意の位置に文字を出すに

してもコードだけだと何度も実行しては座標を見る

などトライ＆エラーが必要となります．　

　Unityのようにエディタで調整し，完成イメージ

が分かった上でその他の機能を実装するのとでは開

発速度にも大きな差が出てきます．

　「簡単かどうか？」はほかの手段との比較により

ますが，ネイティブで自力実装ができる力や他ツー

ルや開発環境での実装経験があればそれらは Unity

を使う場合でも活きてきます．「Unityを使えば誰

でも簡単に～ができる」とはいかないかもしれませ

んが，それまでの経験や知識の蓄積を活かしより早

く，高度な開発ができるとはいえます．

　また，前章で書いたようにUnityはさまざまな分

野で使われていますので普段とは違う分野のソフト

ウェア開発やデモンストレーション制作をしようと

思ったときに同じ環境でそのまま新しいことに挑戦

できます．これも比較的簡単といえる要素の1つです．

Unityをいつ学ぶか？
　すべてのソフトウェアやサービスには得意不得意

がありますし，学習コストもゼロではありません．

目の前にやらなければならないことがあり，締切も

決まっている状態で新しいことを学ぶのは難しいこ

とです．勉強を始めてもそれができるかどうか，も

しくはできるレベルに到達するかどうか読めないと

始めるかどうかの判断もできません．

　だからこそ，実際に広く使われているツールや開

発環境などは余裕があるうちに試しておくとよいで

す．かつてはUnityも研究室に配属されてから勉強

し，夏休みくらいには研究に使えるようになってデ

モンストレーションを作り，そのまま卒業研究に突

入するという流れが多かったようですが昨今は学部

1，2年のうちに授業やサークルなどでUnityを使っ

ており，研究室配属後すぐに活躍できるというケー

スも増えています．昨今は中高生のUnityユーザも

増えており高校生以下のUnityプログラムコンテス

ト「Unityインターハイ」☆ 6では非常にハイレベルな

作品が投稿されるようになってきています．

　以上のように，勉強するタイミングが早ければ早

いほど活躍しやすいといえます．ただ，Unityを使

う上で C#でのコーディングはほぼ避けて通れませ

ん．ノーコーディングでもある程度のものは作れま

すが，基本的に Unityはプログラミングを助ける

ための開発環境として設計されています．本会の会

誌を読んでいる方の多くはプログラミングそのもの

に対してはあまり抵抗がないかとは思いますが，プ

ログラミング未経験もしくは学習の途上という場合，

自身の学んできたことを試す意味でUnityを使って

みるというのも有効です．自身が作ったものが実際

に動くと学習意欲はより高まります．

Unityを始めてみよう
　Unityを使おうと思ってから実際に始められるま

でには実は少々時間がかかります．いざ使おうと

思ったときに出鼻をくじかれないよう，時間の余裕

があるときにまずUnityをダウンロードしておきま

しょう．Webサイト☆ 7からダウンロードが可能です．

ダウンロード元のサイトは変更されることがありま

すが，検索エンジンで「Unity ダウンロード」など

と入力するとすぐに見つかります．

　Unityにはいくつかのライセンスがあります．ど

のように使うかによって必要なライセンスは変わっ

☆ 6 http://inter-high.unity3d.jp/
☆ 7 http://unity3d.com/jp/get-unity/download（2017年 10月 31日確認）
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てきます．学習，研究目的で個人の PCにUnityを

インストールする場合は Personal Editionを選択し

てください．ただし，学校所有の PCなどにUnity

をインストールする場合は教育用ライセンスが必要

です．教育用ライセンスは 2016年 11月より無料と

なりました．Webサイト☆ 8から申し込んでください．

2017 年 10 月 31 日現在，およそ 160 校に対し

32,000本の教育用ライセンスが発行されています．

ライセンスはライセンスキー 1つにつき何本という

ように発行されますので，できれば申込みをする際

に同じ学科，学部ですでに教育用ライセンスを発行

していないかどうかを確認し，共同で申し込んでく

ださい．将来的に使用すると予想される分も含めて

多めに申し込んで問題ありません．

　なお，業務で Unityを使う場合や学校でもソフト

ウェアをパブリッシングしたい場合などは Person-

al Editionを使うことはできません．そういった場

合は Plusもしくは Professionalを使ってください．

Unityを使ってみよう

Unity のインストール
　さて皆さん，そろそろ Unityをインストールし

ておこうという気になってきたでしょうか？　前述

したようにいつか使うときのために「とりあえずイ

ンストールしておいた」という状態にしておきま

しょう．今回は自分の PCに Personal Editionをイ

ンストールする場合について書いていきます．

　まず前述したサイトからインストーラをダウン

ロードし，Download Assistantを起動しましょ

う．規約への同意などをした後，インストールする

コンポーネントを選択する画面になります（図 -3）．
Unityはマルチプラットフォームに対応しており，

Windows，Mac，iOS，Androidなどさまざまなア

プリケーションをビルドすることができます．イン

☆ 8 http://bit.ly/UnityEdu

ストール時に必要なものを選んでおき，コンポー

ネントは後から別途インストールすることもでき

ますのでとりあえずという場合は使っている OS

とWebGL Support，スマートフォン向けに iOS

か Androidの必要な方を選択しておきましょう．

Standard Assetや Sample Projectなども入れてお

くと参考にするのに便利です．またコードエディ

タを同時にインストールすることができます．Mac

の場合はMonoDevelop，Windowsの場合は Visual 

Studioとなっていますがこれらは別なものに変え

ることも可能です．

Unity の起動
　インストールが済んだら一度起動してみましょう．

最初に Unity IDを入れてログインする画面が出て

きます．初めてインストールする場合は Unity ID

を作るところから始めることになります．Unity ID

は個人と紐付くものですので，ずっと使うつもりで

作るとよいです．後に説明するAsset Storeなどで

買い物をした場合もデータはこの Unity IDと紐付

くことになります．ネットワークがつながらない場

合はWork Offlineをクリックしログインせずに使

うこともできます．

プロジェクトを始める
　ログインするとまずプロジェクトの選択画面が

出てきます．なお，もう 1つのタブに Learnと

いう項目がありチュートリアル用のプロジェクト

■図 -3　コンポーネント選択画面
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をダウンロードして基礎を学ぶことができますが，

そちらをやってみようと思う方はこの先を読む必

要はありませんのでチャレンジしてみてください．

チュートリアルのページを見ながら進めてみると

よいでしょう（図 -4）☆ 9．

　それ以外の方はここから簡単にUnityを使ってみ

ましょう．Projectsタブにある Newをクリックし，

適当なプロジェクト名を入れて始めます．2D/3D

の選択をするボタンがありますが今回は 3Dのプロ

ジェクトです．

Unityでドミノ倒しを作る
戻ってくるドミノ倒し
　皆さんは「戻ってくるドミノ倒し」という動画を

ご存じでしょうか？　レンガを並べ片側から倒して

いくと，すべて倒れた後，斜めに倒れていたレンガ

が逆側から平らにもう一度倒れるというものです☆ 10．

　これを Unityで再現してみましょう．

床を作る
　まずは画面上部のメニューからWindows→ Lay-

outsの中から 2 by 3を選択してください．慣れたら

好きなスタイルでよいですが，今回は説明のスクリー

ンショットと同じ構成の方が分かりやすいですね．

　まずはドミノを置くための床が必要です．Hier-

archyビューは置かれているすべてのオブジェクト

がリスト表示されるウィンドウがありますが，その

☆ 9 https://unity3d.com/jp/learn/tutorials
☆ 10 https://streamable.com/6c89d 

上部の Createメニューから 3D Object→ Planeと

選んでください． 

　Sceneビューと Gameビューに白い平らな床が

できましたね．Sceneビューは空間にオブジェクト

を配置するためのウィンドウ，Gameビューはその

Sceneビューを配置されたカメラから見た様子を表

示するもので，実際にプロジェクトを再生したとき

にどうなるかを示しています．

ドミノブロックを作る
　次にもう一度同じように Create → 3D Ob-

ject→ Cubeと選んで立方体を画面に出しましょう．

出現した Cubeオブジェクトは地面にめりこんでい

ますので次は場所を調整します．Sceneビューの上

にあるツール（図 -5）の中から移動ツールを選択し，
Sceneビューで Cubeをクリックする，もしくは

Hierarchyビューから選択してください．X軸，Y

軸，Z軸それぞれを示すハンドルが出ていますので

それをドラッグするとオブジェクトを動かすことが

できます．また，このままではドミノとしてはちょっ

とずんぐりしていますので拡縮ツールを使って大き

さも調節します．

　画面が遠い，角度が合わず見えにくいという場合

は画面移動ツールを使って Sceneビューのカメラを

調整しましょう．ドラッグすると画面の移動，Mac

の場合はOption，Windowsの場合はAltを押しなが

らドラッグすると画面を回転させることができます．

　ツールだけだと正確な調整が難しいと感じるよう

■図 -4　起動画面 ■図 -5　Scene ビューで使うツール

視点移動ツール視点移動ツール

オブジェクト
移動ツール
オブジェクト
移動ツール

オブジェクト
拡縮ツール
オブジェクト
拡縮ツール

オブジェクト
回転ツール
オブジェクト
回転ツール
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なら Inspectorビューを使いましょう．2 by 3の場

合右側にあります．Serviceが全面に出ている場合

は Inspectorを押して切り替えてください．

　Inspectorにはそのオブジェクトについているコ

ンポーネントがすべて表示されています．すべての

オブジェクトには Transformという位置情報を示

すコンポーネントがついており，ここに直接数字を

入れてもオブジェクトの位置を動かせます．ツール

でおおまかな位置や大きさの調整をし，Inspector

で調整するというのが一般的です．

　図 -6のように数値を入れると Cubeをドミノの

ブロックのような形にすることができます．なお，

Positionの単位はメートルです．一見相対的な大き

ささえ保てばよいように思えますが物理処理を加え

る際に大きさが合っていることは重要ですので憶え

ておいてください．

オブジェクトに色をつける
　床とブロックができましたが，このままだと床も

ブロックも白く見にくい状態になっています．せっ

かくですので色をつけましょう．Projectビュー

の CreateメニューからMaterialを選択して新しい

Materialを作りましょう．できたMaterialを選択

すると InspectorにMaterialの調整項目が表示さ

れますのでAlbedoの右にあるカラーパレットをク

リックして色を調整してください．適当な色をつけ

たらMaterialをそのまま Cubeや Planeにドラッ

グすると色がつきます（図 -7）． 

ドミノを倒す
　最初の 1枚が倒れないとドミノ倒しはできません．

そこで，今の 1枚のブロックを倒すためにボールを

用意します．Hierarchyの Create→ 3D Objectから

Sphereを作りましょう．この Sphereの位置を調整し，

落としてブロックを倒せるようにしましょう（図 -8）．
物理処理を加える
　では早速ボールを落としてみましょう．エディタ

上部に再生ボタンがありますのでそれを押してくだ

さい．はい，何も起きませんね．それではブロック

とボールに物理処理がされるようコンポーネントを

加えてみましょう．ブロックを選択して Inspector

の最下部を見るとそこに Add Componentという

ボタンがあります．それを押し，Physics→ Rigid-

bodyを選びます．次は同じようにボールにも

Rigidbodyをつけてください．両方につけたらもう

一度再生ボタンを押しましょう．無事にボールが落

■図 -6　Inspector

■図 -7　Material

■図 -8　ブロックとボールの位置
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ちてブロックを倒したでしょうか？　うまくいかな

い場合は少し位置を調整してみましょう．

ドミノを並べる
　あとはドミノを並べるだけです．ブロックを選択

して右クリック（Macの場合は Control+クリック）

をし，Duplicateしましょう．同じ位置に同じブロッ

クがもう 1つできました．Inspectorの位置を調整

して 2メートルずらします．これを何度も繰り返し

て 10個ほど並べてみましょう．

カメラを調整する
　再生する前に Gameビューのカメラを調整しま

しょう．HierarchyビューでMain Cameraを選択

しオブジェクト移動ツールとオブジェクト回転ツー

ルを使って Gameビューを見ながら適切な位置に

動かします（図 -9）．
ドミノ倒しの完成
 それでは今度こそドミノ倒しを動かしてみましょ

う．再生ボタンを押したら無事にドミノは 2回倒れ

たでしょうか？　無事に動くと以下の動画のように

なります☆ 11．

アプリケーションのビルド
　うまく動いたらアプリケーションにしてみましょ

う．まず Files→ Save Scenesで現在開いている

シーンを保存します．次に File→ Build Settingを

開きAdd Open Scenesを押して開いているシーン

をビルドの対象に加えます．次に Buildボタンを押

☆ 11 https://youtu.be/4vKB3bQLiUM

し，ビルドを開始しましょう．ビルドが終了すると

アプリケーションの完成です．慣れるとここまで

数分の作業で到達できます．ターゲットを iOSや

Androidに変更するとスマートフォン向けのアプ

リケーションをビルドすることも可能です．なお，

Unity Cloud Buildを利用すると Xcodeがインス

トールされていない PCでも iOS向けのアプリケー

ションがビルド可能です（ただし Provisioningファ

イルなどの設定にはMacが必要です）．

さらに手を加える
　紙面が足りないので実際に手を動かす作業はここ

までにしておきますが，今後どのようなことができ

るか書いておきます．今回はコーディングなしで作

れる部分までですがAdd Component→New Script

でスクリプトを加えると C#のプログラムでさまざ

まな処理ができるようになります．たとえば重力で

落ちるだけだったボールをキー入力で動かす，とい

うような処理は数行のコードで作ることができます．

　そのあたりは「はじめての Unity」☆ 12などで学

ぶことができますので参考にしてください．ライ

ティングなどもう少し凝ってみたいというときは

Window→ Asset Storeを開き，Post Processing 

Stackをダウンロードしてカメラに加え，被写界深

度（Depth of Field）やアンビエントオクリュージョ

ンなどを設定してみましょう．また，動かすのが

ボールでは物足りない，背景が寂しいという場合は

Asset Storeに無料で使えるキャラクタや背景グラ

フィックスが数多く用意されています．

　また，マルチプラットフォームに対応する際には

インタフェースなどの対応が必要となります．そう

いった際にはたとえばバーチャルパッドと呼ばれる

スマートフォンの画面上でゲームパッドの動作をエ

ミュレートするような UIを用意する，PCだった

らマウスクリックで動くようなオブジェクトを画面

のタッチに対応させておく処理などが必要です．

☆ 12 http://tutorial.unity3d.jp ■図 -9　カメラの調整
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Unityを学ぶ

さまざまな学び方
　Unityには数多くの公式，非公式の学習手段が用

意されています．たとえばサークルや研究室など集

団で初心者向けの講習を行うときは前述の「はじめ

ての Unity」がお勧めです．互いに分からないころ

を教え合って進めれば長くても 3時間程度ですべて

終わらせることができるはずです．

　Arduinoとの接続などに関して公式のチュートリ

アルはないのですが，検索するといろいろと見つけ

ることができます．Unityは頻繁にアップデートが

されていますので検索期間を絞った方がよいでしょ

う．また，参照するときはどのバージョンのときに

書かれたものか注意して見ておきましょう．

　Unity県人会議☆ 13では開催地別に勉強会やイベ

ントなどの情報を得ることができます．また，自身

でそういったものを開催するときは登録しておくと

集客に役立つかもしれません． 

　また，Unityキャラバンという制度を利用すると

Unity Technologies Japanに対して勉強会やイベ

ントなどの支援要請をすることができます☆ 14ので

サークルや研究室，学校などで勉強会やイベントを

開きたいというときには検討してみてください．

ある程度使えるようになったら
　ある程度Unityが使えるようになったら自分で何か

作ってみるというのはもちろんですが，ハッカソンな

どに参加してみるのも 1つの手です．短期間で物作り

をするという経験そのものが役立つのに加え，スキル

の高い技術者と交流が持てることがあります．ゲーム

関係では 3日間かけて行うGameJamというハッカソ

ンイベントが頻繁にありますが 3日できっちり完成さ

せようとする文化があり他のハッカソンとは少し違う

趣があってお勧めです．ブレインストーミングからプ

☆ 13 https://kenjin.unity3d.jp 
☆ 14 https://kenjin.unity3d.jp/caravan_list.html 

ロトタイピング，本制作，デバッグ，公開までのフロー

を 3日で体験することができます．

Unityを研究に活かす
　Unityのメリットは考えたことを形にするまでの期

間を短縮できるというところにあります．先ほど作っ

たドミノ倒しの例では動画を見てこう並べればこの

ように倒れるのではないか，という仮説を数分で確

認することができています．

　裏を返せば，Unityが使えても解決すべき課題や仮

説を適切に持っていないと研究に役立てることはで

きません．Unityはあくまで研究の問題解決のための

道具で，自分の持つ力を増加させるためのツールです．

　すでに Unityを研究で活かしている方はぜひ，自

身の研究室や学科の後輩にそのノウハウを共有して

あげてください．

　最近では Unityで機械学習を行うための ml-

agentを公開するなどゲーム開発だけでなく非ゲー

ム分野に役立つ機能の実装も進められています☆ 15．

　今後も Unityが情報処理分野の研究の発展に寄

与できるようがんばっていきたいと思いますので，

ぜひみなさんも Unityを使ってさまざまな新しい

研究にチャレンジしてみてください．
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